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since the charges flow electronically from the EHR to 

the PM.” As Ms. Patel continued to describe some of 

the upcoming changes, Joseph Sanchez, the 

practice’s coder, and Chris Yakamoto, the billing 

specialist, begin sending text messages back and 

forth. “With all the changes, u think we’ll still have 

jobs in 6 months?,” Chris wrote. Joseph replied, “Not 

sure. Have 2 wait & see I guess.”

What do you think made Chris and Joseph nervous 
about their job security? As you read this chapter, 
think about how the jobs of coders and billing 
specialists will be different in an office with an 
integrated PM/EHR.

Reason to Worry?

Today the staff is meeting with Tiffany Patel, the 

consultant who is helping the Family Care Clinic make 

a smooth transition from paper records to electronic 

records. A major portion of the meeting is devoted to 

understanding the impact of the change on office 

workflow—the order in which tasks are completed. 

Ms. Patel explains that workflow in an electronic office 

differs from workflow in a paper-based office. She 

provides several examples. “When you have an 

integrated PM and EHR, you no longer need paper 

encounter forms, or superbills,” she explains. “Also, 

there is no need to enter office visit charges manually, 

LEARNING OUTCOMES
When you finish this chapter, you will be able to:

 3.1 List the practice management and electronic health record 
applications in Medisoft Clinical.

 3.2 Discuss three security features in Medisoft Clinical that protect 
patients’ health information.

 3.3 List the menus in Medisoft Clinical Patient Records.

 3.4 List the menus in Medisoft Network Professional.

 3.5 Describe how pre-encounter tasks are completed in 
Medisoft Clinical.

 3.6 Describe how encounter tasks are completed in Medisoft Clinical.

 3.7 Describe how post-encounter tasks are completed in 
Medisoft Clinical.

 3.8 Explain how to create and restore backup files in Medisoft Clinical.

 3.9 Discuss the types of help available in Medisoft Clinical.
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 4. Use a toolbar button to view charges and 
payments.

 5. Back up files.
 6. Restore files.
 7. Access Medisoft Help.

WHEN YOU FINISH THIS CHAPTER, 
YOU WILL ALSO BE ABLE TO USE 
MEDISOFT CLINICAL TO:
 1. Use a menu command to open a patient chart.
 2. Use a toolbar button to open a patient chart.
 3. Use a menu command to view charges and 

payments.

SOFTWARE SKILLS
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 3.1 Medisoft Clinical: A Practice Management/ 
Electronic Health Record Program

Medisoft Clinical is a practice management and electronic health 
record program for physician practices. The program is widely used 
in medical practices throughout the United States. Most of the con-
cepts and techniques used in operating Medisoft Clinical are similar 
to those in other PM/EHR programs. Once you are familiar with 
Medisoft Clinical, you should be able to transfer many skills taught 
in this book to other programs. Throughout this text/workbook, we 
refer to the practice management application as Medisoft Network 
Professional (MNP) and to the electronic health record application 
as Medisoft Clinical Patient Records (MCPR).

This chapter begins with an overview of security features in 
Medisoft Clinical, and then introduces the practice management 
and electronic health record applications. Finally, the chapter 
describes how these applications are used to accomplish the tasks 
in the medical documentation and billing cycle, which you read 
about in Chapter 1.

 3.2 Security Features in Medisoft Clinical
Medisoft Clinical has a number of built-in security features to ensure 
compliance with the HIPAA and HITECH privacy and security 
regulations.

User Names and Passwords
In order to log in to Medisoft Clinical, an individual must have a 
user name and a password. The use of user names and passwords 
prevents unauthorized access to the program, safeguards critical pa-
tient information, and protects patient confidentiality. As passwords 
are entered, the characters are replaced with asterisks (*) on the 
screen so there is no chance that someone will see the actual pass-
word characters. The system may be set up to limit the number of 
log-in attempts. If the number of unsuccessful attempts exceeds the 
number permitted, the user will not be allowed to access the system 
for a period of time, or in some cases, without a system administra-
tor’s intervention. The Medisoft Clinical Patient Records Sign In 

screen is illustrated in Figure 3.1.
Requiring people to log in limits access to the pro-

gram to those who have been assigned log-ins, and 
also allows the actions of users within the program to 
be tracked through an audit report. The audit func-
tion can be used to track changes made in the pro-
gram as well as identify those who made the changes.

The Login/Password Management dialog box 
assists in the management of passwords and log-in 
attempts (see Figure 3.2). The program can be 
configured to control the following aspects of pass-
word management:

Figure 3.1 Medisoft Clinical Patient Records Sign 
In Screen

Medisoft Clinical an integrated 
PM/EHR

Medisoft Network 
Professional (MNP) practice 
management application within 
Medisoft Clinical

Medisoft Clinical Patient 
Records (MCPR) electronic 
health record application within 
Medisoft Clinical

user name name that an 
individual uses for identification 
purposes when logging onto a 
computer or an application

password confidential 
authentication information
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Renewal Interval Indicates how frequently users must 
change their passwords, in this case every ninety 
days.

Reuse Period Indicates how long users must wait 
until they can reuse their last password. Here it is 
set so that they cannot select the same password for 
a period of thirty days.

Minimum Characters Indicates the minimum num-
ber of characters allowable for a password. In this 
case, passwords must be at least eight characters in 
length.

Maximum Characters Indicates the maximum number of characters 
allowable for a password. In this case, passwords must be no more 
than fifteen characters in length.

Require Alphanumeric When this box is checked, a password must 
contain at least one number and at least one letter.

Maximum Allowed Attempts Indicates how many unsuccessful log-
in attempts may be made before a user is locked out of the program. 
Here a user is allowed three log-in attempts. After the third failed 
log-in attempt, the user is locked out of the program.

Account Disable Period Users are locked out of the program for a 
specified period of time when the maximum number of log-in 
attempts has been exceeded.

Access Levels
Access levels define which areas of the program a user can view, 
and whether the user can only view the information or can also add, 
edit, or delete it. The program can be set up with a number of access 
levels for different positions in the office, such as receptionist, physi-
cian, nurse, medical assistant, and billing specialist. The program 
can also specify whether a user has to enter a password to access 
certain areas of the program. In most offices, access levels corre-
spond to the user’s job function on a need-to-know basis. If the user 
needs to know the information to perform tasks associated with the 
position, access is granted. If the information is not relevant to the 
user’s job function, access may be denied. For example, a staff mem-
ber responsible for scheduling may not be able to view a patient’s 
laboratory test results. Likewise, a user responsible for following up 
on insurance claims may be able to view visit documentation in the 
patient chart, but not add, edit, or delete information. In Figure 3.3, 
the first column lists specific areas within the program, and the re-
maining columns represent the allowed actions for a user: Access, 
New, Edit, View, Del (delete), Pswd (password required). Access 

Figure 3.2 Medisoft Network Professional Login/
Password Management Dialog Box

access levels security option 
that determines the areas of the 
program a user can access, and 
whether the user has rights to enter 
or edit data
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levels play a major role in ensuring the security and confidentiality 
of patient records in a practice.

The Park Feature and Auto Log Off
The privacy and security feature in MCPR known as park allows a 
user to leave a workstation for a brief time without having to exit the 
program. When a workstation is parked, it cannot be accessed with-
out reentering a valid operator’s user name and password. If some-
one were to walk by and see the screen while the user was away 
from the computer, he or she would see the screen illustrated in 
Figure 3.4 rather than patient data.

The Auto Log Off feature in MNP performs a similar function. If 
no activity is detected for a specified number of minutes, the pro-
gram automatically logs out the user.

Figure 3.3 Screen Showing the Areas of MCPR That a Medical Assistant Can 
Access, Edit, or View

THINKING IT   THROUGH 3.1

Both Medisoft Clinical applications contain features that are designed to protect 
the privacy of patient information. When would it be an advantage for a 
computer to go into Park? Auto Log Off? When would it be a disadvantage to 
use software with these features?

park privacy and security feature in 
MCPR that allows a user to leave a 
workstation for a brief time without 
having to exit the program

Auto Log Off feature of MNP 
that automatically logs a user out 
of the program after a period of 
inactivity
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 3.3 Medisoft Clinical Patient Records
Medisoft Clinical Patient Records (MCPR) is the electronic health 
record component of Medisoft Clinical. The program stores patient 
information in a number of databases. A database is a collection of 
related pieces of information. Each section of a patient chart is repre-
sented by a yellow folder, similar to folders used in a paper-based 
office. The term chart refers to a patient’s medical record. Informa-
tion about the patient is entered in the appropriate folder.

Practices can customize the patient chart to include the folders that are 
relevant to their particular practice. Commonly used folders include:

• Progress notes

• Past medical history

• Social history

• Family history

• Consults

• Discharge summary

• Orders

• Messages

• Problem list (including diagnosis)

• Health maintenance

• Rx/medications

• Vital signs

• Laboratory data

• Images

• X-ray

• ECG

• Pathology

Figure 3.4 MCPR Screen in 
Park Mode

database a collection of related 
bits of information

chart folder that contains all 
records pertaining to a patient
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Exploring the Main Medisoft Clinical 
Patient Records Window
The main screen, pictured in Figure 3.5, contains a number of different 
features.

Title Bar The title bar states the title of the program.

Menu Bar The menu bar contains the menus of MCPR commands. 
The names of the standard menu items are File, View, Task, Mainte-
nance, Reports, Window, and Help. The menus and commands 
available may change depending on the task that is being performed. 
For example, the Maintenance menu will not appear when working 
in the patient chart because maintenance tasks cannot be performed 
while a patient chart is open.

Toolbar Located below the menu bar, the toolbar provides instant 
access to important MCPR functions (see Table 3.1). Clicking a but-
ton activates the related function in the program. The buttons on the 
toolbar vary depending on which function is in use.

The Dashboard
The main screen also displays the provider dashboard. The dash-
board offers providers a convenient view of important information, 

Figure 3.5 Main Medisoft Clinical Patient Records Window

dashboard a panel in MCPR that 
offers providers a convenient view of 
important information
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including messages, a to-do list, unsigned lab orders, notes, and 
more. Look at Figure 3.5 to view the provider dashboard in MCPR.

The main areas of the dashboard are Schedule, Messages, Lab 
Review, To Do. and Note Review. To access any of these features 

TABLE 3.1 Icons in the Medisoft Clinical Patient 
Records Toolbar

Button Button Name Activity

Exit Closes the charts and exits the program.

Park Protects the system from other viewers by 
locking the screen, requiring the next user to 
log in with a user name and password.

Dash Opens the dashboard if it is not already open.

Chart Opens a chart. More than one chart can be 
open at a time.

Sched Opens the Appointment Scheduler program.

Patient Opens a patient’s registration screens for 
access to demographic information.

Chk In Checks in patients and tracks them through 
the visit.

Pat In Displays a patient’s demographic information.

Msg Enables staff to send messages (e-mail) to 
other staff members.

Review Displays the provider’s review bin, which is 
similar to an in basket. All unsigned items go 
here automatically, including lab results, prog-
ress notes, and other incoming transmissions, 
to wait for the provider to review them.

Letter Enables the writing of letters about specific 
patients and sends them to consulting 
physicians.

Prov Changes the display to another provider 
or clinic.

Help Provides access to help features.
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directly from the desktop, you would click the title of the section, 
such as Messages or To Do.

Schedule
The schedule area presents the provider’s daily schedule with ap-
pointment time, patient name, length of visit, reasons for visit, 
whether the patient has checked in, and, if so, which room the pa-
tient is in.

Messages
The Messages section lists electronic messages for the provider. 
Unread messages appear in bold type. Information provided in 
this area includes the message priority (0 to 9), the sender of the 
message, the subject, and the date the message was received.

Lab Review
The Lab Review area presents lab results that the current provider 
needs to review. Information includes patient name, patient identifi-
cation number, date of the lab work, and time the results were sent.

To Do
The To Do section of the dashboard lists action items for the pro-
vider, including the date the item was added to the list, the priority 
assigned to the task (1 to 9), the patient name, the patient identifica-
tion number, and the subject of the item.

Note Review
This area presents notes for the provider to review, and contains a 
patient name, the date and time of the note, and the note’s subject.

❏ You have completed Exercise 3.1✓

STARTING MEDISOFT CLINICAL PATIENT RECORDS 

AND LOGGING IN 

Start the Medisoft Clinical Patient Records application and log in.

 1. Click Start > All Programs > Medisoft Clinical - Client > Medisoft 
Clinical Client. The Medisoft Clinical Sign In window appears.

 2. Enter medasst in the User ID field. Notice that the Practice ID 
field was completed by the program.

 3. Enter master1$ in the Password field.

 4. Click the drop-down triangle in the Provider ID field. The 
Provider Select dialog box opens.

 5. Click the second line to select John Rudner, MD and click the 
OK button. You are returned to the Sign In screen.

 6. Click OK. A Disclaimer screen appears. Click OK again.

 7. The main Medisoft Clinical Patient Records window is displayed.

EXERCISE 3.1
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 3.4 Medisoft Network Professional
Medisoft Network Professional (MNP) is the Medisoft Clinical 
application used for patient accounting. MNP also includes Office 
Hours, a scheduling program. Physician practices use MNP to:

• Schedule appointments

• Register patients

• Enter charges

• Create insurance claims

• Post payments

USING A MENU COMMAND TO OPEN 

A PATIENT CHART

Practice selecting a menu command to open a patient chart.

 1. Click the File menu, and select Open Chart. The Patient Lookup 
dialog box is displayed.

 2. Click the Lookup button. A list of patients appears.

 3. Click the line that contains the entry for Janine Bell. The line is 
blackened.

 4. Click the OK button. Janine Bell’s chart opens.

 5. Click Close Chart on the File menu to close the patient’s chart.

EXERCISE 3.2

❏ You have completed Exercise 3.2✓

USING A TOOLBAR BUTTON TO OPEN 

A PATIENT CHART

Practice using a toolbar button to open a patient chart.

 1. Click the Chart button on the toolbar. The Patient Lookup 
dialog box is displayed.

 2. Click the Lookup button. A list of patients appears.

 3. Click the line that contains the entry for Janine Bell. The line is 
blackened.

 4. Click the OK button. Janine Bell’s chart opens.

 5. Click the Close button on the toolbar to close the patient’s chart.

EXERCISE 3.3

❏ You have completed Exercise 3.3✓
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• Create statements

• Follow up on accounts

• Create reports

Exploring the Main Medisoft Network 
Professional Window
The main window in Medisoft Network Professional contains the 
title bar, menu bar, and toolbar (see Figure 3.6).

Title Bar The title bar states the title of the program.

Menu Bar Medisoft Network Professional offers choices of actions 
through a series of menus. Commands are issued by clicking options 
on the menus or by clicking shortcut buttons on the toolbar. The menu 
bar lists the names of the menus in Medisoft Network Professional: 
File, Edit, Activities, Lists, Reports, Tools, Window, and Help. Beneath 
each menu name is a pull-down menu with one or more options.

Toolbar Located below the menu bar, the toolbar contains twenty-
six buttons with icons that represent the most common activities 
performed in MNP (refer to Figure 3.6). These buttons are short-
cuts for frequently used menu commands. When you click a 

Figure 3.6 Main Medisoft Network Professional Window
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button, the corresponding MNP dialog box opens. For example, 
clicking the Claim Management button opens the same dialog box 
as does selecting the Claim Management option on the Activities 
menu. When you move your cursor over an icon, a description of 
the icon is displayed. Throughout this text/workbook, the buttons 
can be used instead of the pull-down menus to perform common 
tasks. Table 3.2 lists the toolbar buttons and their associated 
activities.

❏ You have completed Exercise 3.4✓

STARTING MEDISOFT NETWORK PROFESSIONAL 

AND LOGGING IN

Start the Medisoft Network Professional application and log in.

 1. Click Start > All Programs > Medisoft > Medisoft Network Pro-
fessional. The Medisoft User Login – Family Care Clinic window 
appears.

 2. Enter billing in the Login Name field.

 3. Enter master1$ in the Password field and click OK. The main 
Medisoft Network professional window is displayed.

EXERCISE 3.4

❏ You have completed Exercise 3.5✓

USING A MENU COMMAND TO VIEW CHARGES 

AND PAYMENTS

Practice selecting a menu command to view a patient’s charges and 
payments.

 1. Click the Activities menu, and select Enter Transactions. The 
Transaction Entry dialog box is displayed.

 2. Click the drop-down list button in the Chart field, and click 
Janine Bell. The charge and payment transactions for an office 
visit appear.

 3. Review the two charges listed in the top section of the 
dialog box.

 4. Review the payments entered by Herbert Bell (Janine’s father) 
and the insurance plan, East Ohio PPO.

 5. Click the Close button to close the dialog box.

EXERCISE 3.5
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TABLE 3.2 Medisoft Network Professional Toolbar Buttons

Button Button Name Activity

Transaction Entry Enter, edit, or delete transactions.

Claim Management Create and transmit insurance claims.

Statement 
Management

Create statements.

Collection List View, add, edit, or delete items on collection list.

Add Collection 
List Item

Add items to the collection list.

Appointment Book Schedule appointments.

View Eligibility 
Verification Results 
(F10)

Review results of eligibility verification 
inquiries.

Patient Quick Entry Use predefined templates to enter new 
patients.

Patient List Enter patient information.

Insurance 
Carriers List

Enter insurance carriers.

Procedure 
Code List

Enter procedure codes.

Diagnosis Code List Enter diagnosis codes.

Provider List Enter providers.

Referring Provider 
List

Enter referring providers.

Address List Enter addresses.

Patient Recall Entry Enter patient recall data.

Custom Reports 
List

Open a custom report.

(continued)
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TABLE 3.2 (continued)

Quick Ledger View a patient’s ledger.

Quick Balance View a patient’s balance.

Enter Deposits and 
Apply Payments

Enter deposits and payments.

Show/Hide Hints Turn the Hints feature on and off.

Medisoft Help Access MNP’s built-in help feature.

Edit Patient Notes 
in Final Draft

Use the built-in word processor to create and 
edit patient notes.

Launch Medisoft 
Reports

Obtain access to additional reports.

Launch Work 
Administrator

Assign tasks to practice staff.

Exit Program Exit the MNP program.

 3.5 Using Medisoft Clinical to Complete 
Pre-Encounter Tasks

In Chapter 1, you learned about the medical documentation and bill-
ing cycle. The tasks associated with each step in the cycle were origi-
nally performed using paper forms, without the assistance of 

❏ You have completed Exercise 3.6✓

USING A TOOLBAR BUTTON TO VIEW CHARGES 

AND PAYMENTS

Practice using a toolbar button to view a patient’s charges and payments.

 1. Click the Transaction Entry button on the toolbar. The Transac-
tion Entry dialog box is displayed.

 2. Click the drop-down list button in the Chart field, and click Janine 
Bell. The charge and payment transactions for an office visit appear.

 3. Click the Close button to close the dialog box.

EXERCISE 3.6
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computers. Computers were first used in the physician practice for 
scheduling and billing. Today, practices both large and small are 
shifting from paper medical records to electronic health records. The 
tasks formerly completed using paper are now performed electroni-
cally through the use of computers.

The remainder of this chapter explains how computer software—
specifically Medisoft Clinical—is used to accomplish the tasks associ-
ated with each step in the cycle. In this section, the steps are grouped 
into three categories: pre-encounter, encounter, and post-encounter.

Preregistration
The pre-encounter steps include preregistration and appointment 
scheduling. Preregistration consists of entering basic information 
about the patient in Medisoft Network Professional. The demo-
graphic information is entered in the Patient/Guarantor dialog box, 
which is accessed via the Lists menu (see Figure 3.7). When Patients/
Guarantors and Cases is selected on the Lists menu, the Patient List 
dialog box is displayed (see Figure 3.8).

To enter preregistration information about a new patient, click the 
New Patient button. The Patient/Guarantor dialog box is displayed 
(see Figure 3.9). Basic information such as the patient’s name, ad-
dress, and telephone numbers are entered in the Name, Address tab. 
Additional information, including the assigned provider, are entered 
in the Other Information tab. The Payment Plan tab is usually not 
used during preregistration.

Entering the Chief Complaint/Reason for Visit
If information about the patient’s chief complaint—the patient’s de-
scription of the symptoms or reasons for seeking medical care—is 
gathered during preregistration, a case must be created. Cases con-
tain detailed information required to submit insurance claims. In 
MNP, the case folder consists of twelve tabs. During preregistration, 

Figure 3.7 Patients/
Guarantors and Cases Selection 
on the Lists Menu

Figure 3.8 Patient List Dialog Box

chief complaint patient’s 
description of the symptoms or 
reasons for seeking medical care
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Figure 3.9 Patient/Guarantor Dialog Box

a new case is created, and the chief complaint is entered in the De-
scription field of the Personal tab. Figure 3.10 displays the Case dia-
log box with the Personal tab selected.

Scheduling Appointments
The preferences of physician practices vary in regard to scheduling 
software. Some practices prefer to schedule appointments in a sepa-
rate scheduling program, while others use a scheduling program 
that is built into a practice management or electronic health record 
program. In the exercises in this text/workbook, we will use Office 
Hours for patient appointments. Office Hours is a scheduling pro-
gram included with Medisoft Network Professional. The main Office 
Hours screen is shown in Figure 3.11.

The following steps are used to enter an appointment in Office 
Hours:

 1. Select a provider in the provider box in the upper-right corner 
of the Office Hours window.

 2. Select a date in the calendar in the upper left corner of the 
window.
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Figure 3.10 Case Dialog Box

Figure 3.11 Main Areas of the Office Hours Window
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 3. Click a time slot in the provider’s daily schedule in Column 1. 
The New Appointment Entry dialog box is displayed (see 
Figure 3.12).

 4. Complete the New Appointment Entry dialog box, and click 
Save.

Preregistration and scheduling are covered in detail in Chapter 4.

 3.6 Using Medisoft Clinical to Complete 
Encounter Tasks

The encounter steps include all activities that take place from the 
time the patient arrives for an office visit until the patient leaves 
the office.

Establishing Financial Responsibility
In Medisoft Network Professional, the patient’s insurance informa-
tion is entered in one or more of the Policy tabs in the Case folder 
(see Figure 3.13). If the patient has just one policy, only the Policy 1 
tab is completed. If the patient has additional plans, the Policy 2 tab 
and possibly the Policy 3 tab must also be completed. The Policy 

Figure 3.12 The New Appointment Entry Dialog Box

THINKING IT   THROUGH 3.2

Most physician practices use computerized scheduling programs. Think about the 
steps required to find an open time slot and to enter a patient appointment. What 
do you think are the main advantages of a computerized scheduling program?
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tabs contain information about the patient’s health plan coverage, 
including the name of the policyholder, the policy number, the co-
payment or deductible amount, and more.

Checking Insurance Eligibility
The Policy tabs also contain a button that is used to make a real-time 
eligibility inquiry about a patient. In Figure 3.13, the button used to 
begin an eligibility check is highlighted in yellow. Using an Internet 
connection, the program sends an eligibility verification request to 
the patient’s health plan and, in response, receives an eligibility re-
sponse report that states whether the patient is eligible for benefits 
under the health plan.

The topic of eligibility verification is covered in detail Chapter 4.

Check-in
The check-in step includes a number of administrative and clinical 
activities, including:

• Checking in the patient and reviewing the patient’s account 
balance

• Gathering and recording additional patient information

• Examining the patient and documenting the examination

• Coding the services performed and exporting the information 
to Medisoft Network Professional for claims and billing

Figure 3.13 Case Folder with Policy 1 Tab Selected
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Checking In and Reviewing Account Balance
As patients assume more of the financial responsibility for 
health care, medical offices look for more efficient ways to 
check patients’ balances and discuss any payments that are 
due while the patient is in the office. For this reason, the ap-
pointment schedulers inside Medisoft Clinical Patient Re-
cords and Medisoft Network Professional contain features 
to help facilitate the collection of time-of-service payments. 
Since this text/workbook uses Office Hours, a program 
within MNP, for scheduling, that is where check-in will 
take place. Figure 3.14 shows an appointment on the provider’s sched-
ule with a check mark to indicate that the patient has checked in. Fig-
ure 3.15 illustrates the Quick Balance dialog box, a feature within the 
scheduling program that enables front desk personnel to easily view a 
patient’s balance during check-in.

Gathering and Recording Additional Patient Information
After patients check in at the front desk, they are given additional 
forms to complete, including a patient information form and a medi-
cal history form. Patients are also given several HIPAA documents, 
such as a Notice of Privacy Practices, an Acknowledgment of Re-
ceipt of Notice of Privacy Practices, and an Authorization to Use or 
Disclose Health Information. Most practices also provide patients 
with a copy of the practice’s financial policy.

The information obtained during check-in is 
entered in several places in MNP. Most of the in-
formation on the patient information form is 
recorded in the Patient/Guarantor dialog box and 
in the Personal, Account, and Policy tabs of the 
Case folder. The data from the medical history form 
are reviewed by a medical assistant once the patient 
is taken to an exam room.

The HIPAA forms that are signed by the patient 
and returned to the front desk may be scanned and 
included in the patient record.

Check-in, patient registration, and account balance 
review are covered in Chapter 5.

Documentation and Examination
After waiting to be called, the patient is escorted to the exam room, 
and a medical assistant or other clinical staff member interviews the 
patient and measures the patient’s vital signs. The type and length of 
the interview depends on a number of factors, including whether 
the patient is new to the practice, the nature of the chief complaint, 
and the purpose of the visit (for example, new condition or routine 
follow-up). When a provider sees a patient for the first time, it is im-
portant to obtain the patient’s medical history, allergies, and medica-
tions, as well as the chief complaint/reason for visit.

Medical History The medical history information is entered in the 
Past Medical History, Social History, and Family History tabs in 
Medisoft Clinical Patient Records (see Figure 3.16).

Figure 3.14 Patient Appointment with 
Checked-in Status

Figure 3.15 Quick Balance Dialog Box
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Chief Complaint The chief complaint/reason for visit is recorded in 
the Problem List folder. The Problem List folder lists major problems, 
other problems, procedures, diagnoses, risks, and hospitalizations 
(see Figure 3.17).

Allergies and Medications A patient’s allergies and medications are 
entered in the Rx/Medications folder. Allergies are listed at the top of 
the dialog box, and medications are grouped into current, ineffective, 
and historical categories. A date box indicates the last date on which 
the allergies were reviewed (see Figure 3.18).

Figure 3.16 Patient Chart with Medical, Social, and Family History Folders Identified

Figure 3.17 Problem List 
Folder with Other Problems Tab 
Selected
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Measuring and Recording Vital Signs Vital signs are recorded and en-
tered in the Vital Signs folder in MCPR. The Vital Signs dialog box 
contains fields for all commonly used vital signs and measurements 
(see Figure 3.19). As each measurement is taken, it is entered in the 
appropriate field.

The topics of medical history, chief complaint, allergies and medi-
cations, and entering vital signs are covered in Chapter 6.

Physician Examination During the office visit, a physician evaluates, 
treats, and documents a patient’s condition. The visit documentation 
varies depending on a number of factors, including whether the patient 

Figure 3.18 Rx/Medications Folder with Current Folder Selected

Figure 3.19 Vital Signs Dialog Box
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is new or established. When examining a new patient, a complete re-
view of systems may be appropriate. Once the patient is established, 
the visit focuses more on his or her current medical needs.

A number of methods are used to organize and record visit docu-
mentation. The most common method of documenting is called a 
problem-oriented medical record (POMR). The problem-oriented 
medical record has a general section with data from the initial patient 
examination and assessment. When the patient makes subsequent 
visits, the reasons for those encounters are listed separately (in the 
Problem List folder) and have their own notes.

A problem-oriented medical record contains SOAP notes. In the 
SOAP format, a patient’s encounter documentation has four parts: 
Subjective, Objective, Assessment, and Plan:

S: The subjective information is what the patient names as the 
problems or complaints.

O: The objective information includes relevant positive and nega-
tive physical findings; it may include data from laboratory tests 
and other procedures.

A: The assessment, also called the impression or conclusion, is the 
physician’s diagnosis.

P: The plan, also called advice or recommendations, is the course 
of treatment for the patient, such as surgery, medication, or 
other tests, including instructions to the patient and necessary 
patient monitoring and follow-up.

In Figure 3.20, a SOAP note entered in MCPR has been color-coded 
to show the S, O, A, and P sections. The SOAP format is used for the 
exercises in this text/workbook.

Figure 3.20 Progress Note in 
SOAP Format
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Figure 3.21 Order Dialog Box with Order for a Triglycerides Test

If the physician wants laboratory or radiological tests performed, 
orders are entered in the Orders folder of the patient chart. Figure 
3.21 displays an order for a blood test for triglycerides.

Orders for new medications or renewals of existing prescriptions 
are entered in the Rx/Medications folder. An order for a new pre-
scription is displayed in Figure 3.22. Prescriptions can be printed 
and given to the patient, or they can be electronically transmitted to 
the patient’s pharmacy.

Coding
Once the examination is complete and the documentation has been 
entered in MCPR, the services provided and the provider’s deter-
mination of the patient’s diagnoses must be assigned numeric 
codes. In some cases, physicians assign these codes; in others, med-
ical coders or medical billers perform this task. In either instance, 
the codes are determined by reviewing the documentation. 
Whether physicians receive payment from health plans depends in 
part on the diagnosis and procedure codes assigned to the visit. 
Both types of information are used to calculate the charges for the 
visit, and must be reported to insurance plans in order to receive 
payment for services.

In MCPR, codes are selected from lists provided on an electronic 
encounter form (see Figure 3.23). In this example, the procedures 
performed were coded as 99212 and 84478. The diagnosis code, 
531.30, was assigned to both procedures.
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Figure 3.23 Electronic Encounter Dialog Box

Figure 3.22 Prescription Dialog Box
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Figure 3.24 The Activities Menu with Unprocessed Transactions > Unprocessed 
EMR Charges Selected

Transmit Charges to Medisoft Network 
Professional for Billing
Once the coding is complete, the visit charges are transmitted elec-
tronically to Medisoft Network Professional. The charges are auto-
matically transmitted every few minutes, with the exact amount of 
time specified by the user.

The charges appear in MNP in the Unprocessed Transactions 
dialog box, which is accessed by selecting Unprocessed Transac-
tions > Unprocessed EMR Charges on the Activities menu (see 
Figure 3.24).

The topics of documenting a patient visit, coding a visit, and 
transferring charges to Medisoft Network Professional are described 
in Chapter 7.
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Checkout
During patient checkout, payments are calculated and posted, 
follow-up appointments and tests are scheduled, patient education 
materials are dispensed, and referrals are provided.

Coding and Billing Compliance Review
The Unprocessed Charges dialog box lists charges that have come 
from Medisoft Clinical Patient Records since the last time charges 
were posted (see Figure 3.25). Before the charges are posted to a pa-
tient’s account, they must be reviewed for billing and coding 
compliance.

Diagnosis and procedure codes must be up-to-date and must 
follow the official guidelines of the American Hospital Associa-
tion and the American Medical Association. In addition, the 
procedures and diagnosis must establish the medical necessity of 
the charges. If the guidelines are not followed or if medical 
necessity is not met, the physician will not receive payment from 
the health plan.

Health plans have different rules for what is required on health 
care claims, and they use sophisticated technology to check or “edit” 
incoming claims to determine whether to accept them for process-
ing. If a claim does not pass the edit, it will be rejected. While it is not 
possible to memorize all health plans’ rules, reviewing charges be-
fore sending claims will ensure that more claims are accepted on 
their first submission.

In Medisoft Network Professional, charges are reviewed in the 
Unprocessed Transactions Edit dialog box, which is displayed by 
clicking the Edit button in the Unprocessed Charges dialog box. The 
Unprocessed Transactions Edit dialog box lists detailed informa-
tion, including information about the patient, the procedures, the 
diagnosis, and the charges (see Figure 3.26). If the billing compli-
ance review finds a problem with the transaction, the charges can 
be held as unprocessed until the problem is corrected. If the review 
determines that the transaction is complete and accurate, the 

Figure 3.25 Unprocessed Charges Dialog Box
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Figure 3.26 Unprocessed Transactions Edit Dialog Box

charges are posted to a patient’s account. Clicking the Post button 
enters the charges into the Transaction Entry dialog box in MNP 
(see Figure 3.27). Transactions are not finalized until the Save but-
ton is clicked.

Billing and coding compliance is covered in Chapter 9.

Calculate and Post Time-of-Service (TOS) Payments
When a patient goes to the checkout desk, a staff member reviews 
the amount that the patient owes for the visit. In some cases, nothing 
is owed at the time of service. The claim will be submitted to the 
patient’s health plan, and the patient will not be billed until the 
claim is processed. In other cases, patients pay for all or a portion of 
services at the time of the visit. A patient may be responsible for a 
small copayment or a percentage of estimated charges.

Patient payments are entered in the Transaction Entry dialog box. 
Figure 3.28 shows the Transaction Entry dialog box after a $15.00 
patient copayment has been recorded. The payment line is high-
lighted in yellow.

If a patient makes a payment at the time of service, a receipt is 
typically printed. The Print Receipt button at the bottom of the 
Transaction Entry dialog box generates a receipt, which can be 
printed and given to the patient. Figure 3.29 displays a sample pa-
tient receipt.

Posting time-of-service payments is discussed in depth in 
Chapter 9.
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Figure 3.27 Transaction Entry Dialog Box with Transactions Posted

Figure 3.28 Transaction Entry Dialog Box with Patient Copayment Posted
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Figure 3.29 Patient Receipt for Payment

Additional Checkout Activities
The final step of the checkout process includes scheduling any 
follow-up appointments ordered by the provider, such as return office 
visits, laboratory tests, or radiology services; providing referrals or 
prescriptions as required; and providing related patient education 
materials as ordered by the provider.

Scheduling is performed in Office Hours, the Medisoft Network 
Professional scheduling program. Referrals and prescriptions are 
created from within Medisoft Clinical Patient Records, as are patient 
education materials. Figure 3.30 shows a sample patient education 
handout selected in MCPR.
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 3.7 Using Medisoft Clinical to Complete 
Post-Encounter Tasks

After the patient visit is complete, activities focus on payment for 
services, including preparing and transmitting claims, monitoring 
payer adjudication, generating patient statements, and following up 
on payments and collections. 

Preparing and Transmitting Claims
To receive payment, a medical practice must create and submit 
claims to health plans. In Medisoft Network Professional, claim 
functions are located on the Activities menu (see Figure 3.31).

The Claim Management dialog box lists current claims. New 
claims are created in the Create Claims dialog box (see Figure 3.32).

Claims are transmitted to health plans through MNP’s Reve-
nue Management feature. In addition to transmitting electronic 

Figure 3.31 Activities Menu 
with Claim Management Selected

THINKING IT   THROUGH 3.3

Electronic health record programs store patients’ vital signs and laboratory 
results. Most programs provide an option to view patient results from a 
specified period of time in a graph. What is an advantage of viewing vital signs 
or test results in a graph?

Figure 3.30 Patient Education Selection
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Figure 3.32 Create Claims Dialog Box

claims, Revenue Management checks outgoing claims for errors be-
fore sending them to the health plan. Claim management is covered 
in detail in Chapter 10.

Monitoring Payer Adjudication
The health plan reviews the claim and determines whether it will be 
paid in full, partially paid, or denied. The results of the claim review, 
including an explanation of why charges were not paid in full or 
were denied entirely, are sent to the provider along with the pay-
ment. This information is reviewed for accuracy by a member of the 
billing staff, such as a medical insurance specialist. If any discrepan-
cies are found, a request for a review of the claim is filed with the 
payer. If no issues are discovered, the amount of the payment is re-
corded. The payment may be in the form of a paper check, or it may 
be sent electronically to the practice’s bank.

In Medisoft Network Professional, the first step in entering health 
plan payments is to select Enter Deposits/Payments on the Activi-
ties menu. The Deposit List window is displayed. Clicking the New 
button brings up the dialog box used to enter payment information 
(see Figure 3.33).

san74946_ch03_104-150.indd Page 135  10/12/10  11:05 AM user-f463san74946_ch03_104-150.indd Page 135  10/12/10  11:05 AM user-f463 /Volume/208/MHCE016/san74946_disk1of1/0073374946/san75292_pagefiles/Volume/208/MHCE016/san74946_disk1of1/0073374946/san75292_pagefiles



C
o

p
y
ri

g
h

t 
©

 2
0
1
2

 T
h

e
 M

c
G

ra
w

-H
ill

 C
o

m
p

a
n

ie
s

136    PART 1 MANAGING THE REVENUE CYCLE

Once the deposit is recorded, it is applied to charges in individual 
patients’ accounts in the Apply Payment/Adjustment to Charges 
dialog box (see Figure 3.34).

Generating Patient Statements
After payments from health plans have been received, patients are 
billed for any remaining balances. Patient statements are created in 
Medisoft Network Professional and are sent to patients. A statement 
lists all services performed, along with the charges for each service. 

Figure 3.33 Deposit Dialog Box

Figure 3.34 Apply Payment/Adjustments to Charges Dialog Box
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Figure 3.35 Activities Menu 
with Statement Management 
Selected

Figure 3.36 Create Statements Dialog Box

It also lists the amount paid by the health plan and the remaining 
balance that is the responsibility of the patient. While some practices 
send statements electronically via e-mail, some practices still mail 
paper statements.

The Statement Management option on the Activities menu con-
tains options for creating and printing patient statements (see Fig-
ure 3.35).

Selections in the Create Statements dialog box determine which 
statements will be created. The program allows filtering by 
 patient, date, minimum amount owed, and other criteria (see Fig-
ure 3.36).

A sample patient statement is displayed in Figure 3.37.
The topics of posting insurance payments and creating patient 

statements are presented in Chapter 11.

Following Up on Payments and Collections
Because a medical practice must be successful as a business as 
well as a provider of health care services, it must track the money 
that is coming in and going out. Medisoft Network Professional 
provides a large number of reports that enable office managers 
to closely monitor accounts.

For example, practices regularly print a report that lists outstand-
ing patient balances (see Figure 3.38). The information in this report 
identifies accounts that require follow-up.

Most physician practices have financial policies that specify 
when an account should be placed in collections. In Medisoft 
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Patient Aging 
Report

Figure 3.37 
Patient Statement
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Figure 3.39 Activities Menu 
with Collection List Selected

Figure 3.40 Tickler Item Dialog Box

THINKING IT   THROUGH 3.4

In an office with an integrated PM/EHR, charges from an office visit are sent 
electronically to the practice management application. However, they are not 
immediately posted to patient accounts. A member of the billing staff must 
intervene and click a Post button to enter the charges. Since posting charges 
immediately seems more efficient, why do you think the program does not 
work that way? What is the reason for the delay?

Network Professional, collection functions are located on the Ac-
tivities menu and on the Reports menu. Selecting Collection List 
on the Activities menu is the first step in placing an account in col-
lections (see Figure 3.39).

When Collection List is selected, the Collection List dialog box ap-
pears. Clicking the New button displays the Tickler Item dialog box 
(see Figure 3.40). Once the Tickler Item dialog box has been com-
pleted, the account appears in the Collection List.

Medisoft Network Professional also facilitates the creation of col-
lection letters. The option for creating collection letters is located on 
the Reports menu (see Figure 3.41).

Figure 3.42 shows a sample collection letter.
Follow-up on patient accounts and the collections process are dis-

cussed in Chapter 13.
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 3.8 Backing Up and Restoring Files
With the increasing use of PM/EHR systems, physician practices are 
more dependent on information technology than ever before. This in-
creased reliance on technology, coupled with the HIPAA Security 
Rule, has forced practices to develop and implement disaster recovery 
plans. A disaster recovery plan is a plan for resuming normal opera-
tions after a disaster such as a fire or a computer malfunction.

Backing Up Files
Disaster recovery plans require practices to back up computer data.
Backing up refers to the process of saving a copy of files on a regu-
lar schedule to facilitate file recovery if data loss occurs. During a 
backup, files are copied from their normal location to a different 
location. The files may be copied to portable media, such as tapes 
or drives, or they may be transferred over a computer network 
such as the Internet. Most practices back up data on a daily basis, 
and store one copy of the backup in the office, and the other at an 
offsite location. Using an offsite location for storage protects the 
data should a natural disaster such as a fire or flood occur at the 
office. When Hurricane Katrina struck New Orleans, many medical 
records were destroyed. While most of these were paper records, it 
is also true that electronic records are not immune from disasters. 
In fact, computerized records are subject to additional threats, such 
as computer viruses and hardware malfunctions. As a result of the 

Figure 3.41 Reports Menu with Collection Reports >Patient Collection Letters 
Selected

disaster recovery plan plan 
for resuming normal operations after 
a disaster such as a fire or a 
computer malfunction

backing up making a copy of 
data files at a specific point in time 
that can be used to restore data
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lessons learned from Hurricane Katrina, medical facilities are more 
aware of the importance of backing up data.

Files that are backed up can be restored. Restoring is the process 
of copying backup files onto the office’s computer systems, facilitat-
ing a return to normal business activities.

In Medisoft Network Professional, the Backup Data option on the 
File menu can be used to make a backup copy of the database at any 
time (see Figure 3.43).

The Medisoft Backup dialog box pictured in Figure 3.44 lists the 
destination file path and name of the file being created, and also lists 
existing backup files.

Figure 3.42 Collection Letter
Figure 3.43 File Menu with 
Backup Data Selected

restoring process of retrieving 
data from a backup storage device
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Restoring Files
The steps required to restore a backup file 
are very similar to the steps used to back 
up a file. To restore 09302016.mbk to the 
Medisoft Network Professional directory 
on the C drive (C:\MediData\FCC):

 1. Select Restore Data on the File menu.

 2.  When the Warning box appears, click 
OK. The Restore dialog box appears.

 3.  In the Backup File Path and Name 
box at the top of the dialog box, enter 
the location of the backup file, if this 
name is not already displayed.

 4.  The Destination Path at the bottom of 
the box should already show C:\
MediData\FCC.

 5. Click the Start Restore button.

 6.  When the Confirm box appears, click 
OK.

 7.  An Information dialog box appears 
indicating that the restore is com-
plete. Click OK to continue.

 8.  Click the Close button to close the 
Restore dialog box.

❏ You have completed Exercise 3.7✓

BACKING UP

Practice creating a backup file in Medisoft Network Professional.

 1. Select Backup Data on the File menu. The Medisoft Backup 
dialog box is displayed.

 2. In the Destination File Path and Name box, enter C:\FCC\

Backup_Files\2016\09\09302016.mbk.

 3. Medisoft automatically displays the location of the database 
files to be backed up in the Source Path box in the lower half of 
the dialog box.

 4. Click the Start Backup button.

 5. The program backs up the latest database files and displays an 
Information dialog box indicating that the backup is complete. 
Click OK.

 6. Close the Medisoft Backup dialog box by clicking the Close button.

EXERCISE 3.7

Figure 3.44 Medisoft Backup Dialog Box
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 3.9 The Medisoft Clinical Help Feature
Medisoft Network Professional and Medisoft Clinical Patient Re-
cords offer built-in and online help files. These resources provide 
detailed explanations of program features, list common errors, and 
offer tips designed to improve user productivity.

Built-in Help
The built-in help feature is accessed by selecting an option on the 
Help menu. Figure 3.45 shows the Medisoft Help selection on the 
Help menu in MNP.

When this option is selected, the Help dialog box opens, and the 
contents of the Help feature are displayed (see Figure 3.46).

Figure 3.45 Medisoft Help 
Selection on Help Menu

Figure 3.46 Contents of 
Medisoft Help Feature

❏ You have completed Exercise 3.8✓

USING MEDISOFT CLINICAL HELP

Practice using MNP’s built-in help.

 1. Click the Help menu.

 2. Click Medisoft Help. Medisoft displays a list of topics for which 
help is available.

 3. Click the plus sign to the left of the entry for Entering Pay-
ments. A list of subtopics is displayed.

 4. Click Apply Payment to Charges. The article appears in the 
right column.

 5. Use the scroll bar to view the rest of the article.

 6. Click the Close box in the upper-right corner to close the Help 
window.

EXERCISE 3.8
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Figure 3.47 MNP Online Knowledge Base

Online Help
The Help menu also provides access to help available on the MNP 
website at www.medisoft.com. The website contains a searchable 
knowledge base, which is a collection of up-to-date technical infor-
mation about Medisoft products (see Figure 3.47).

knowledge base a collection of 
up-to-date technical information
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chapter 3 summary

The practice management application in Medisoft Clinical is 
called Medisoft Network Professional (MNP), and the electronic 
health record application is Medisoft Clinical Patient Records 
(MCPR).

- User names and passwords are assigned to individuals to pro-
tect unauthorized access, safeguard patient information, and 
protect patient confidentiality.

- Access levels are assigned to job functions to specify who has 
access to information on a need-to-know basis; the user must 
enter a user name and password to see the information and to 
have editing and other privileges.

- The park feature allows a user to walk away from the com-
puter and still safeguard the information; it requires the next 
user to enter a user name and password to gain access. The 
Auto Log Off feature logs off a user after a specified period of 
inactivity. Both keep passers-by from viewing or accessing 
information.

The names of the standard menus in Medisoft Clinical Patient 
Records are File, View, Task, Maintenance, Reports, Window, and 
Help. The menus and commands available may change depend-
ing on the task being performed.

The menus in Medisoft Network Professional are File, Edit, 
Activities, Lists, Reports, Tools, Window, and Help.

The pre-encounter steps include preregistration and appointment 
scheduling. Preregistration consists of entering basic information 
about the patient in Medisoft Network Professional. The demo-
graphic information is entered in the Patient/Guarantor dialog 
box, which is accessed via the Lists menu. A case is created, and 
the chief complaint is entered in the Personal tab. An appoint-
ment is scheduled in Office Hours.

3.1 List the practice 
management and electronic 
health record applications 
in Medisoft Clinical.
Page 106

3.2 Discuss three 
security features in 
Medisoft Clinical that 
protect patients’ health 
information.
Pages 106–108

3.3 List the menus in 
Medisoft Clinical Patient 
Records.
Pages 109–113

3.4 List the menus 
in Medisoft Network 
Professional.
Pages 113–117

3.5 Describe how  
pre-encounter tasks 
are completed in 
Medisoft Clinical.
Pages 117–121

LEARNING OUTCOME KEY CONCEPTS/EXAMPLES

• Practice Exercises
• Worksheets

• Activities
• Integrated eBook

Enhance your learning at mcgrawhillconnect.com!
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LEARNING OUTCOME KEY CONCEPTS/EXAMPLES

The following tasks are handled in Medisoft Clinical during the 
encounter:

- Insurance information is entered and eligibility is checked in 
the Policy tab.

- At check-in, the account balance is reviewed, payment may be 
obtained, and additional patient information is gathered and 
recorded.

- Documentation and examination take place, with the medical 
assistant or other clinical staff member doing part of it, and a 
physician doing and documenting the actual physical 
examination.

- The diagnosis and procedures are coded, and charges are 
transmitted to MNP for billing. These are reviewed for coding 
and billing compliance.

- Claims are prepared and transmitted in the Claim Manage-
ment dialog box of MNP.

- The health plan’s determination and payment are reviewed, 
starting with the Deposit dialog box.

- Patient statements are generated in the Create Statements 
dialog box.

- Follow-up takes place by creating a patient aging report.

Files are backed up by choosing Backup Data on the File menu 
and entering the information in the Backup dialog box. They are 
restored by choosing Restore Data on the File menu and provid-
ing the required information in the dialog box.

Medisoft Clinical offers two types of help. Built-in help is avail-
able on the Help menu. Online help is obtained from the knowl-
edge base on the MNP website.

3.6 Describe how 
encounter tasks are 
completed in 
Medisoft Clinical.
Pages 121–134

3.7 Describe how 
post-encounter tasks 
are completed in 
Medisoft Clinical.
Pages 134–139

3.8 Explain how to 
create and restore backup 
files in Medisoft Clinical.
Pages 140–142

3.9 Discuss the types of 
help available in Medisoft 
Clinical.
Pages 143–144
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MATCHING QUESTIONS

Match the key terms with their definitions.

  1. [LO 3.2] password

  2. [LO 3.8] restoring

  3. [LO 3.3] chart

  4. [LO 3.3] dashboard

  5. [LO 3.1] Medisoft Clinical 
Patient Records (MCPR)

  6. [LO 3.5] chief complaint

  7. [LO 3.2] user name

  8. [LO 3.3] database

  9. [LO 3.9] knowledge base

 10. [LO 3.8] backing up

a. Panel in MCPR that offers providers a conve-
nient view of important information.

b. Confidential authentication information.

c. Name that an individual uses for identifica-
tion purposes when logging onto a computer 
or an application.

d. Making a copy of data files at a specific point 
in time that can be used to restore data.

e. Collection of up-to-date technical 
information.

f. Electronic health record application within 
Medisoft Clinical.

g. Folder that contains all records pertaining to a 
patient.

h. Patient’s description of the symptoms or 
reasons for seeking medical care.

i. Process of retrieving data from a backup 
storage device.

j. Collection of related bits of information.

TRUE-FALSE QUESTIONS

Decide whether each statement is true or false.

  1. [LO 3.2] Access levels define which areas of the program a user can view, and 
whether the user can only view the information or can also add, edit, or de-
lete it.

  2. [LO 3.6] The encounter steps include only activities that take place before the 
patient arrives for an office visit.

  3. [LO 3.8] Disaster recovery plans require practices to back up computer data.

  4. [LO 3.9] A user must be online to access any of the help features for Medisoft 
Network Professional and Medisoft Clinical Patient Records.

  5. [LO 3.1] Medisoft Clinical is a practice management and electronic health 
record program for physician practices.

  6. [LO 3.4] Medisoft Network Professional is the Medisoft application used for 
patient accounting.

chapter review
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  7. [LO 3.2] In order to log in to Medisoft Clinical, an individual needs to have 
only a user name.

  8. [LO 3.5] The pre-encounter steps include preregistration and appointment 
scheduling.

  9. [LO 3.3] Medisoft Clinical Patient Records is the personal health record 
component of Medisoft Clinical.

 10. [LO 3.7] The results of a claim review are sent to the provider along with the 
payment.

MULTIPLE-CHOICE QUESTIONS

Select the letter that best completes the statement or answers the question.

 1. [LO 3.6] Once an examination is complete and the documentation has been entered in 
MCPR, the services provided and the provider’s determination of the patient’s diag-
noses must be assigned .
a. letters
b. numeric codes
c. names
d. all of the above

 2. [LO 3.8] A plan for resuming normal operations after a disaster such as a fire or a 
computer malfunction is a .
a. back up plan
b. restoring plan
c. disaster recovery plan
d. all of the above

 3. [LO 3.2] Which of the following is a built-in security feature of Medisoft Clinical?
a. user names
b. passwords
c. access levels
d. all of the above

 4. [LO 3.9] The website contains a searchable  which is a collection of up-to-
date technical information about Medisoft products.
a. database
b. dashboard
c. knowledge base
d. user name
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 5. [LO 3.5] The pre-encounter steps include .
a. appointment scheduling
b. preregistration
c. claim preparation
d. both a and b

 6. [LO 3.3] The term  refers to a patient’s medical record.
a. chart
b. database
c. dashboard
d. consult

 7. [LO 3.8] What is the process of copying backup files onto the office’s computer sys-
tems, facilitating a return to normal business activities?
a. restoring
b. backing up
c. parking
d. both a and b

 8. [LO 3.7] To receive payment, a medical practice must create and submit 
to health plans.
a. diagnoses
b. claims
c. statements
d. adjudication

 9. [LO 3.7] A statement lists .
a. all service performed
b. the amount paid by the health plan
c. the charges for each service performed
d. all of the above

10. [LO 3.4] Medisoft Network Professional includes , a schedule program.
a. Medisoft Clinical Patient Records
b. Auto Log Off
c. Office Hours
d. none of the above
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SHORT-ANSWER QUESTIONS

Define the following abbreviations.

1. [LO 3.1] MCPR  

2. [LO 3.1] MNP 

APPLYING YOUR KNOWLEDGE

Answer the questions below in the space provided.

3.1. [LO 3.2] How do access levels contribute to the security of patients’ health 
information?

 

3.2. [LO 3.5] Some practices use built-in scheduling programs such as Office Hours, 
while others prefer to have scheduling programs separate from their PM programs. 
What advantages do you think using a built-in scheduling program offers?

3.3. [LO 3.6] What advantages are offered by the ability to make a real-time eligibility 
check on patients’ insurance?

3.4. [LO 3.7] Why is it important for medical practices to monitor payer adjudication?
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